CHAPTER 1

TARGET ACQUISITION WEATHER SOFTWARE (TAWS)

OBJECTIVE


Given Electro Optical Tactical Decision Aids software and appropriate data, prepare meteorology & oceanography (METOC) support products to electro-optic systems correctly IAW a master solution.

INTRODUCTION

The Target Acquisition Weather Software (TAWS) predicts the performance of air-to-ground electro-optical weapon and navigation systems.  Performance is expressed primarily in terms of maximum detection or lock-on range.  Results are displayed in graphic and tabular formats.  

TAWS supports systems in three regions of the spectrum: Infrared (3-5 (m; 8-12 (m); Visible (0.4 - 0.9 (m); and Laser (1.06 (m).  The Visible includes both television (TV) and Night Vision Goggles (NVG) systems.

INFORMATION

OVERVIEW

Quick Start


The default installation will install the required files into a directory called TAWS.  To run the application, click the Start button, go to Programs then finding and clicking on TAWS to expose the menu.  To start the application click on the TAWS menu item.  Refer to Figure 1-1.
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Figure 1-1.  Starting The TAWS Application From The Start Menu
After the initial TAWS splash screen has been displayed your display should then look like the example in Figure 1-2.
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Figure 1-2.  TAWS Startup Screen
TAWS SYSTEM DEFAULTS

This section describes how to access the TAWS system defaults and how to change the default settings.  TAWS has default settings for several types of information.  The defaults may be accessed by clicking on the Defaults button in the Choose Objective window or by selecting Defaults from the File menu.  In any case, the TAWS Defaults window appears.  This window contains a tab dialog for several categories of information.  Click on one of the following tabs:

Units 

The Units tab in the TAWS Defaults window allows you to select units to be used for various TAWS inputs and outputs.  The current units for each parameter are shown in the drop‑down list box to the right of the parameter.  To change the units, click on the arrow at the right of the drop‑down list box.  A list of available choices will appear.  Refer to Figure 1-3.
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Figure 1‑3.  TAWS Defaults - Units
Sortie
The Sortie tab in the TAWS Defaults window allows you to specify the default sensor type and height.  To change the default sensor type, click on the IR, TV, or NVG radio button.  Then change the sensor ID number by clicking on the arrow at the right of the drop‑down list box.  A list of valid sensor ID numbers for the selected sensor type will appear.  Click on the choice you wish to make.  The current choice for sensor height is shown in the spinner box to the right of the parameter.  To change the default, click on the arrows in the spinner box or type in a value.  Refer to Figure 1-4.
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Figure 1‑4.  TAWS Defaults - Sortie
Target Acquisition Analysis 

The Target Acquisition Analysis tab in the TAWS Defaults window allows you to specify default analysis parameters.  A target acquisition analysis may be run for a range of times bracketing the actual time over target (TOT) and a range of sensor altitudes bracketing the actual sortie vehicle altitude.  This window allows you to set these ranges and the increments.  Refer to Figure 1-5.
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Figure 1-5.  TAWS Defaults – Target Acquisition Analysis
The range of times is defined by a time interval, the number of intervals before the actual time over target and the number of intervals after the time over target.  The valid choices for time interval are 15, 30, and 60 minutes.  The maximum time period is +/‑ 12 hours from TOT.  The maximum allowable number of time intervals before and after TOT is 12, regardless of what the time interval is.  Note that, if you want to run an analysis for a single time, the actual TOT set the number of intervals before and after TOT to zero.  The current choice for time interval is shown in the drop‑down list box to the right of this parameter.  To change the default, click on the arrow at the right of the drop‑down list box.  A list of available choices will appear.  Click on the choice you wish to make.  The current choices for the other parameters are shown in the spinner boxes to the right of the parameters.  To change the defaults, click on the arrows in the spinner boxes or type in values.

The range of sensor altitudes is defined by the altitude below the actual sortie vehicle altitude, the altitude above the sortie vehicle altitude, and the altitude increment.  Three spinner boxes control the choices for these parameters.  If you want to run an analysis for a single altitude, the actual sortie vehicle altitude set the altitude below and above the sortie vehicle altitude to zero.

Illumination Analysis
The Illumination Analysis tab in the TAWS Defaults window allows you to specify default analysis parameters.  An illumination analysis computes either solar/lunar event times (sunrise, sunset, moonrise, moonset, beginning of nautical twilight, and end of nautical twilight) or solar/lunar positions (solar elevation and azimuth angles, lunar elevation and azimuth angles, and percent lunar illumination) and illumination for up to 31 days.  Refer to Figure 1-6.
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Figure 1-6.  TAWS Defaults –  Illumination Analysis
In either type of illumination analysis, results can be displayed in Coordinated Universal Time (UTC) or in local time.  The current choice is shown in the drop‑down list box to the right of the Time parameter.  To change the default, click on the arrow to the right of the drop‑down list box and then click on the choice you wish to make.

For a solar/lunar position analysis, the model is run for a series of times starting at midnight or noon on the first day and ending at midnight or noon on the last day.  The Orientation parameter allows you to select noon to noon or midnight to midnight.  The valid choices for Time Interval are 15 and 30 minutes, 1, 2, 3, 4, 6, 8, and 12 hours, or 1 day.  To change the defaults for either of these parameters, click on the arrow to the right of the drop‑down list box and then click on the choice you wish to make.

To leave the TAWS Defaults window without saving your changes, click on the Close button.  To save your changes for the current TAWS session only, click on the Apply button and then click on the Close button to close the window.  To permanently save your changes click on the Save button and then click on the Close button to close the window.  The permanently saved changes will automatically be loaded the next time you run TAWS.

SINGLE POINT‑BASED TARGET ACQUISITION

Target acquisition analysis in TAWS involves the computation of detection or lock-on range for a particular target at a particular location under specified weather conditions.  The single point‑based analysis is designed to let a user obtain detection or lock-on range as quickly as possible for a single target at a single location.

You may select this type of analysis by clicking on the Single Point‑Based radio button in the Target Acquisition Analysis box in the Choose Objective window, then clicking on the Next button.  The Point‑Based Target Acquisition window appears on the screen.  The Point‑Based Target Acquisition window gives you access to all required input parameters and output products.  Refer to Figure 1-7.
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Figure 1-7.  Point-based Target Acquisition
Five main steps are involved in conducting a single point‑based target acquisition analysis.  These steps include

· Specifying Target Information

· Specifying operations, or sortie, information

· Specifying weather information

· Running the analysis

· Viewing the results in tabular form or in graphic form

A button in the Point-Based Target Acquisition window represents each of these steps.  The steps are described in the sections below.

The Target… button Ops… button and Weather… button give you access to input windows where you can specify information about your particular target, sortie, and weather.  When you are done specifying information, the information is summarized in the Point‑Based Target Acquisition window.  At any given time, the Point‑Based Target Acquisition window shows the current settings.

At any time when you have consistent target, sortie, and weather information, you can click the Analyze...  button to run a target acquisition analysis.  Note that if you change your target location or your mission date/time, you must review the weather information before you can run an analysis.  In this case, the Analyze...  button is inaccessible.

At any time after you have run an analysis, you can click the View Graph...  or View Table...  buttons to examine the results.  If an analysis has not been run, the View Graph...  and View Table...  buttons are inaccessible.

To leave the Point‑Based Target Acquisition window and return to the Choose Objective window, click on the <Back button.

At any time, you may save the current target, sortie, weather, and results information to your hard disk.  To save the current processing state, select Save from the File menu.  All current information is automatically saved to your hard disk.

To save and name the current processing state, select Save As.  from the File menu.  The Save As window appears on the screen.  You have the opportunity to enter a file name, file type, and folder.  Click on the Save button to save the file and close the Save As window.  Click on the Cancel button to close the Save As window without saving the file.

To recall previously saved information; select Open Point‑Based...  from the File menu.  The Open window appears on the screen.  You have the opportunity to select a folder; the names of all files of type TAWS Point‑Based (*.tpb) that have previously been saved in that folder are listed in the window.  To select a file, click on its name and then click on the Open button.  The target, sortie, and weather information is loaded and the Open window is closed.  Click on the Cancel button to close the Open window without opening the file.

If at any time you attempt to exit TAWS or switch to a different analysis type, a warning message will be displayed asking if you want to save any changes before terminating the current analysis type.  Select Cancel to continue with the current analysis type.  Select No to terminate the analysis type without saving.  Select Yes to save the current screen.  You have the opportunity to enter a file name, file type, and folder.  Click on the Save button to save the file and close the Save As window.  Click on the Cancel button to close the Save As window without saving the file.

Specifying Target Information

To specify target information, click on the Target...  button in the Point‑Based Target Acquisition window.  The Target window appears on the screen.  This window allows you to specify some general information about your target, then gives you access to an input window where you can specify other target properties.  Refer to Figure 1-8.
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Figure 1-8.  Specifing Target Information
To choose a target type, click on the Vehicular, Stationary or Other radio button and then select a target from the drop‑down list box.  The vehicular and stationary target lists are shown in the table below.  The vehicular targets include the standard "ground" targets that were developed for the Electro‑Optical Tactical Decision Aid, as well as refueling tankers that were included in NOWS Version 4.  The stationary targets include the EOTDA "menu" targets, as well as a series of default high‑value targets.  For a point‑based target acquisition analysis, the only other supported target is a customized runway.

Table 1-1.  Available Targets
Vehicular Targets
Stationary Targets

T‑62 Tank
Coffeeville Dam

T‑72 Tank
Destin Causeway Bridge

T‑80 Tank
Eglin AFB Bunker

Z – 157 Truck
Millers Ferry Hydroelectric Power Plant

BRDM‑2 Anti‑Tank Vehicle
Default POL Tank – White

Armored Personnel Carrier
Default Bunker

MICV Light Infantry Vehicle
Default Dam

Field Generator
Default Bridge

Scud Mobile Missile Launcher
Default Power Plant

F‑4 Aircraft
Default Runway – Concrete

Apache Helicopter


Hind Helicopter


Soviet Missile Frigate


Naval Gunboat


Several additional user‑selectable parameters are shown in the Target window.  These parameters allow you to specify an identifier and the location of your target.  The parameters are described below.  When you are finished modifying the general target parameters, you can click on the Properties...  button to specify additional information or click on the Cancel button to leave the Target window and return to the Point-Based Target Acquisition window without saving your changes.  While the OK button in the Target window is always accessible, a warning message will appear if you click on the OK button without clicking on the Properties… button and verifying the additional parameters first

ID.   A name that you use to identify the target.  This parameter is optional.  Choose a name for your target by clicking on the text box to the right of the ID parameter and typing in a name.  There is no limit to the number of characters in your target name.

Comments.  Additional identifying information about the target.  This parameter is optional.  To specify comments, click on the text box to the right of the Comments parameter and type in your comments.  There is no limit to the number of characters in your comments.

Latitude.  The latitude of the target location.  This parameter is shown in the Target window only if your default units for earth location are set to lat/lon.  To change the latitude value, click on the arrows in the latitude degrees and minutes spinner boxes or type in values.  If necessary, click on the N or S radio button.

Longitude.  The longitude of the target location.  This parameter is shown in the Target window only if your default units for earth location are set to lat/lon.  To change the longitude value, click on the arrows in the longitude degrees and minutes spinner boxes or type in values.  If necessary, click on the E or W radio button.

Military Grid Reference System (MGRS).  This parameter is shown in the Target window only if your default units for earth location are set to MGRS.  To change the MGRS value, click on the text box to the right of the MGRS parameter and type in the desired coordinate.  Enter the full MGRS reference.

An example is 17RLD0123456789.  Here 17R is the grid zone designation, LID is the 100,000 m square identifier, 01234 is the eastern (horizontal) value, and 56789 is the northern (vertical) value.  Note that fewer digits may be entered for eastern and northern if lower precision is desired; however, the number of digits used for eastern must be the same as the number specified for northern.

When you click on the Properties.button in the Target window, the target Properties window appears on the screen.  This window allows you to specify additional information about your target.  The additional parameters are described below.  Refer to Figure 1-9.
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Figure 1-9.  Target Properties
Heading.  The direction that the front of the target is facing, in degrees clockwise relative to north.  For example, 270( corresponds to a target that faces west.  For targets that do not have an obvious "front" the front is defined along the target's width.  For a runway, the target heading is the direction that the width of the runway is facing.  For information about the definition of "front" for each TAWS target type, see the target diagrams.  To change the target heading, click on the arrows in the spinner box or type in a value.

Elevation MSL.  The altitude of the target above sea level.  This parameter is used only for IR sensor systems, to compensate for the change in solar down welling due to altitude.  To change the target elevation, click on the arrows in the spinner box or type in a value.

Orientation.  The position of the target relative to a sloped background.  This parameter is used only for TV/NVG sensor systems, to compute the amount of direct and diffuse illumination on the target and to determine the ability of the sensor to see the target.  This parameter is not accessible if all backgrounds have a zero slope.  To change the orientation, select a position from the drop‑down list box.  The following positions are available: At Base, and On Slope.

Speed.  The speed of the target in the direction of the target heading.  This parameter is used only for I R sensor systems, to account for the cooling effects of wind speed and target motion on the target.  This parameter is only accessible for vehicular targets whose operating state is exercised.  To change the target speed, click on the arrows in the spinner box or type in a value.

Operating State.  The expected operating state of the target.  This parameter is used only for IR sensor systems, to properly account for internal heating.  This parameter is only accessible for some of the vehicular targets.  For the tanks, the truck, the personnel carrier, the anti‑tank vehicle, the light infantry vehicle, and the missile launcher, the supported operating states are Off, Idle, and Exercised.  For the generator, the supported operating states are Off and Idle.  For the helicopters, the supported operating states are Off and Hovering.  For the ships and the F‑4, operating state is not a required input.  To change the operating state, select a state from the drop‑down list box.

Clutter/Complexity.  Describes the busyness of the target area.  The clutter/complexity describes in general terms the number of objects in the immediate target vicinity that can be mistaken for the target.  This parameter is used only for IR and NVG sensor systems.  In general, target detection range increases with decreasing clutter/complexity level.  To change the clutter/complexity level, select a level from the drop‑down list box.

General Surface Albedo.  Describes the primary earth surface material in the general target area.  The default category for general surface albedo is estimated from a 1(-resolution land cover database (DeFries and Townshend, 1994), provided as part of the TAWS software.  To change the albedo category, select a category from the drop‑down list box.  The following categories are available for general surface albedo: Continental, Urban, Desert, Ocean, and Snow.

Surface Background.  Describes the material immediately surrounding a target on the surface.  This is the material against which a target on the surface is viewed.  If you are unsure which type of material the target will be viewed against, up to three background types may be entered.  A default surface background type is estimated from a 1‑degree resolution land cover database (DeFries and Townshend, 1994), provided as part of the TAWS software.  To change a surface background type, click on one of the background tabs.  Then select a background type from the drop‑down list box.  Each type has up to three parameters that are used to further define the background.  Each parameter has several different options.  When you select a background type, the associated parameters are updated automatically.  To change a parameter, select one from the dropdown list box.

Slope.  The slope of the surface background.  This parameter is used only for TV/NVG sensor systems, to account for target masking (target hidden from view behind a terrain feature) and reflected illumination onto the target.  To change the slope, click on the arrows in the spinner box or type in a value.

Direction.  The direction of the down slope of a sloped background, specified in degrees clockwise relative to true north.  This parameter is used only for TV/NVG sensor systems, to account for target masking and reflected illumination onto the target.  To change the direction, click on the arrows in the spinner box or type in a value.

Material.  This is the material of the target itself.  This parameter is available only for a customized runway target.  To change the material type, select a type from the drop‑down list box.  The following types are available: Concrete and Asphalt.  Each type has two parameters that are used to further define the material: Surface and Wetness.  To change a parameter, select one from the drop‑down list box.

Length.  This is the length of the target itself.  This parameter is available only for a customized runway target.  To change the length, click on the arrows in the spinner box or type in a value.

Width.  This is the width of the target itself.  This parameter is available only for a customized runway target.  To change the width, click on the arrows in the spinner box or type in a value.

Once you have specified the additional target properties, click the OK button in the target Properties window to return to the Target window.  There, you can click on the OK button to save your changes for the current session and return to the Point-Based Target Acquisition window.  Your changes are reflected in the Point‑Based Target Acquisition window.  Of course, you can click on the Cancel button in either the target Properties window or the Target window to close the window without saving your changes.

Specifying Operations Information

To specify operations, or sortie, information, click on the Ops...  button in the Point-Based Target Acquisition window.  The Sortie Properties window appears on the screen.  This window allows you to specify information about your sortie sensors and time over target (TOT).  The parameters are described below.  Refer to Figure 1-10.
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Figure 1-10.  Specifing Operations Information – Sortie Properties
Sortie Name.  A name that you use to identify the sortie.  This parameter is optional.  Choose a name for your sortie by clicking on the text box to the right of the parameter and typing in a name.  There is no limit to the number of characters in your sortie name.

Sortie Comments.  Additional identifying information about the sortie.  This parameter is optional.  To specify comments, click on the text box below the parameter and type in your comments.  There is no limit to the number of characters in your comments.

Sensors.  The sensor systems being used to detect or lock‑on to a target.   Any number of I R, TV, and NVG sensors may be chosen; one Laser system may be chosen.  To add a system, click on the Add...  button.  The Add Sensor window appears.  Select a sensor Type from the drop‑down list box.  For IR, TV, and NVG types, a list of all sensors of that type in the inventory appears.  To add one sensor, click on the ID number of the sensor you wish to add, then click on the Add button.  The sensor is added to the list in the Sortie Properties window.  To add more than one sensor, click on the first one and hold down the [Ctrl] key while clicking on the others, then click on the Add button.  To add a range of sensors, click on the first one and drag the cursor down the list, or click on the first one and hold down the [Shift] key while clicking on the last one, then click on the Add button.  When you are finished adding sensors, click on the Close button to close the Add Sensor window.  To remove a sensor system from the list, click on the Remove button in the Sortie Properties window.  Refer to Figure 1-11.
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Figure 1-11.  Initial Add Sensor (left) & Selecting Laser System (right)
Sensor Height.  For a Laser system, you must select the Laser system mode from the drop‑down list box.  The mode determines which additional selections must be made: designator, receiver, and ranger information.  See the information below for specifics about what is required for each Laser mode.  Once you are happy with your selections, click on the Add button to add the Laser system to the sensor list in the Sortie Properties window.  Click on the Close button to close the Add Sensor window.  The elevation of the sensor, above the earth's surface.  To change the height, click on the arrows in the spinner box or type in a value.  Refer to Figure 1-10.

Sensor View Direction.  The view direction, or azimuth angle, of the sensor in degrees clockwise relative to north.  For analysis over time, this is the default view direction.  To change this value, click on the arrows in the spinner box or type in a value.  Refer to Figure 1-10.

Date/Time Over Target.  The year, month, day, and time over target.  The default, is the current date and time taken from your computer system clock.  To modify the date, select a month and year from the list boxes, and then click on the day in the calendar control.  To modify the time, click on the arrows in the hours and minutes spinner boxes or type in values.  Refer to Figure 1-10.

For a Laser system, a designator, receiver, and/or ranger may be included.  The system mode refers to the configuration of these systems.  The following table shows the seven possible system modes.  Each mode requires a different set of inputs.  The Add Sensor window automatically makes inaccessible any values that are not required for a selected mode.  Refer to Figure 1-11.

Table 1-2.  Laser Modes

Laser Mode
Description
Computed Range

1
User specifies designator range, designator height, receiver height; No ranger
Receiver range

2
User specifies receiver range, receiver height, designator height; No ranger
Designator range

3
User specifies collocated designator/receiver height; No ranger
Collocated designator / receiver range

4
User specifies receiver range, receiver height, collocated designator/ranger height
Collocated designator / ranger range

5
User specifies designator range, designator height, collocated receiver/ranger height
Collocated receiver / ranger range

6
User specifies collocated designator/receiver/ranger height
Collocated designator / receiver and ranger range

7
User specifies ranger height; No designator or receiver
Ranger range

When you are finished modifying the sortie parameters, you can click on the OK button to save your changes for the current session and return to the Point‑Based Target Acquisition window.  Click on the Cancel button to close the Sortie Properties window without saving your changes.

Specifying Weather Information

To specify weather information, click on the Weather...  button in the Point‑Based Target Acquisition window.  The TAWS Meteorological Data window appears on the screen.  This window allows you to download or enter a weather forecast for the target location for a period of time bracketing the time over target (TOT).  The parameters are described below.  Surface information, boundary layer information, upper layer information, and cloud information must be specified.  Note that in TAWS, weather information is required for a 30‑hour window.  TAWS output is available for a 24‑hour window bracketing the TOT, and the IR model requires an additional 6 hours of weather data for thermal model initialization.  The initial 30‑hour weather window for the location, therefore, goes from TOT‑1 8 to TOT+1 2 hours.  See the note at the end of this section about changes to the weather window.  The beginning forecast time is indicated in a non‑editable text box in the lower left corner of the TAWS Meteorological Data window.  Refer to Figure 1-12.
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Figure 1-12.  TAWS Meteorological Data
Note that an additional non‑editable text box is located in the lower left corner of the TAWS Meteorological Data window.  This text box indicates the overall source of the weather data currently displayed in the window.  If the source is AFWA, then the weather parameter values have been computed using data downloaded from the Air Force Weather Agency (AFWA) web site.  If the source is Defaults, then the weather parameter values have been taken from a simple set of static defaults.  If the source is Copy, then the weather values have been taken from the previous location or TOT that was edited by the user.  If the displayed source is User, then the weather parameter values at the current location and TOT have already been approved by the user.

When you first go to the TAWS Meteorological Data window for a particular location, the initial values will be taken from one of two sources: the weather values of the previous location or TOT you edited, or a set of static defaults.  If you have previously specified weather information for another target location or another TOT, then the values are taken from that location/TOT.  If you have not previously edited the weather information for another location or TOT, then the parameter values are taken from a simple set of static defaults.  The static defaults do not vary by latitude or by the current season, so there is a good chance that the static defaults will not match very well with the weather at your location.

Several requirements must be met before you can download weather from AFWA.  First, you must have a valid AFWIN user ID and password.  Second, you must have previously used your computer to access the internet.  This should ensure that internet connectivity information is in your computer's registry and available to the TAWS program.  To download weather data from the AFWA web site, click on the Download Weather button in the TAWS Meteorological Data window.  The Connect to AFWA window appears.  Enter your AFWA user ID and password, then click on the OK button to initiate the download process.  Messages will appear in the Connect to AFWA window to inform you of the status of the download process.  If the process completes successfully, then the values of the parameters in the TAWS Meteorological Data window are computed or estimated from the AFWA data.  Click on the Close button to close the Connect to AFWA window and return to the TAWS Meteorological Data window.

The TAWS Meteorological Data window shows summary information for each of the required weather parameters.  To view and selectively edit the 30‑hour forecast for a particular parameter, click on the button in the TAWS Meteorological Data window that corresponds to that parameter.  A new window appears, showing the 30‑hour forecast for that parameter or set of parameters.  The 30‑hour forecast starts roughly 18 hours before the TOT (rounded to the nearest hour) and continues until roughly 12 hours after the TOT.  A forecast time increment of 3 hours is used.  The TOT is indicated in a non‑editable text box in the upper right corner of the window.  Color coding is used to indicate the origin of the forecast data.  Any data shown in standard red text are initial values obtained from a set of static defaults.  Any data shown in standard black text are initial values obtained from a previous location/TOT.  Any data shown in blue text are initial values obtained from AFWA.  Any data that have been edited by the user are displayed in green text.  Note that a non‑editable text box is located in the lower left corner of the window.  This text box indicates the overall source of the weather data currently displayed in the window.

The surface layer is defined from the surface up to the boundary layer height.  The upper layer is defined from the boundary layer height to the top of the atmosphere, set to 15 km.  TAWS allows you to specify up to three cloud layers.  Although ground‑based cloud observations cannot report on clouds above an overcast layer, TAWS is sensitive to clouds above an overcast.  It is recommended that you provide additional cloud information above an overcast.

Temperatures.  The Surface Temperature Data window allows you to edit or approve the 30‑hour forecast of surface temperature and dew-point temperature.  The temperature values can be edited by clicking on the Temperature button, then clicking on the value for the time of interest and typing in the desired value.  The dew-point values can be edited by clicking on the Dew-Point button, then clicking on the value for the time of interest and typing in the desired value.  The relative humidity values are not editable, but they are updated as you enter new temperature or dew-point values.  Temperature and dew-point values can be copied by selecting a value and pressing [Ctrl‑C], then pasted to a new location by pressing [Ctrl‑V].

[image: image13.png]Surface Temperature Data

~Diumal Temperature Curve Calculator
Mexand Min Tempersturs | DewPaint Temperature
12.(0) Calculate and
—_— i 10 (9 Insert Below
——— [ ©®
Date 21 Feb 2000 TOT: 22 Fab 20001748 UTC
Time: 2300 0200 0500 0B 1100 1400 1700 2000 2300 0200 500
[Tempeauwre (0 || 12| 12| 12 12 12| 12 12| 12 12| 12 1
DewPaint (C) w [ w[ w[ w[ w[ w[ o[ o[ o[
RH (%) @ e ea| ea| ea| ea| ea| ea| ea| ea| es
8

N





Figure 1-13.  Surface Temperature
Temperature can be initialized to a diurnal curve by entering minimum and maximum values in the top part of the Surface Temperature Data window and then clicking on the Calculate and Insert Below button.  TAWS computes a diurnal cycle by assuming that the minimum temperature occurs at sunrise and the maximum temperature occurs at 1400 local time.  The algorithm uses a sine curve during daylight hours and an exponential decay curve between sunset and sunrise.  Dew-point temperature can be initialized to a constant value by entering the value in the top part of the Surface Temperature Data window and then clicking on the Calculate and Insert Below button.

If you do not modify the temperature and dew-point temperature values after initializing them using the Calculate and Insert Below button, then the diurnal curve is used to generate data every 15 minutes for the TAWS models.  If you do modify the temperature and dew-point values, then a linear interpolation is performed between the 3‑hourly data points to generate data every 15 minutes for the TAWS models.  The difference here is that the linearly interpolated values may miss the sunrise minimum and 1400 maximum values.

The temperature and dew-point temperature is used by the IR, TV/NVG, and Laser models primarily to compute the relative humidity.  Relative humidity, along with aerosol and visibility, is used to compute an extinction coefficient.

Wind Direction/Speed.  The Wind Direction and Speed window allows you to edit or approve the 30‑hour forecast of wind direction and wind speed at the surface.  To edit the values, simply click on an existing value for a time of interest and type in the new value.  A value can be copied by selecting a value and pressing [Ctrl‑C], then pasted to a new location by pressing [Ctrl‑V].  Refer to Figure 1-14.
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Figure 1-14.  Wind Direction and Speed
The IR model uses wind direction; wind speed is used by the I R, TV/NVG, and Laser models.

The Surface Visibility window allows you to edit or approve the 30-hour forecast of visibility at the surface.  To edit the values, simply click on an existing value for a time of interest and type in the new value.  A value can be copied by selecting a value and pressing [Ctrl‑C], then pasted to a new location by pressing [Ctrl‑V].

Visibility.  Visibility is used by the IR, TV/NVG, and Laser models.  The models expect precipitation to be taken into account in the estimate of surface visibility.  Valid visibility values range from 0.  1 to 100.0 km.  Note that the models are sensitive to this parameter.  Visibilities of 10 km and 12 km may indeed produce different model results.  The lower the visibility, the more sensitive the models to changes in the visibility.  Refer to Figure 1-15
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Figure 1-15.  Surface Visibility
Precipitation Type/Rate.  The Precipitation window allows you to edit or approve the 30‑hour forecast of precipitation.  To edit the precipitation type, simply click on one of the radio buttons for a time of interest: None, Rain, or Snow.  If you select Rain, then the Rain Rate parameter becomes accessible.  You can click on the existing value and type in a new value.  A value can be copied by selecting a value and pressing [Ctrl‑C], then pasted to a new location by pressing [Ctrl‑V].  Precipitation type is used by the I R, TV/NVG, and Laser model; precipitation rate is used by the I R and Laser models only.  Refer to Figure 1-16.
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Figure 1-16.  Precipitation
Surface Aerosol.  The Surface Aerosol window allows you to edit or approve the 30‑hour forecast of aerosol type at the surface.  To edit the values, simply click on an existing value for a time of interest and type in the new value, or use the vertical slider to select a value.  A value can be copied by selecting a value and pressing [Ctrl‑C], then pasted to a new location by pressing [Ctrl‑V].  Refer to Figure 1-17.
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Figure 1-17.  Surface Aerosol
Battlefield‑Induced Contaminants.  The Battlefield‑Induced Contaminants window (BIC) allows you to edit or approve the 30‑hour forecast of BIC.  Simply click on one of the radio buttons for a time of interest: No or Yes.  Refer to Figure 1-18.
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Figure 1-18.  Battlefield-Induced Contaminants
Aerosol is used by the IR, TV/NVG, and Laser models.  BIC should be selected when a persistent pall of smoke and dust covers the area of interest.  Visibility is normally between 1 and 3 km, unless the natural aerosol otherwise degrades it.  When BIC is selected, the surface aerosol should correspond to the prevailing air mass.  The models combine BIC and air mass degradation effects.

Boundary Layer Height.  The Boundary Layer Height window allows you to edit or approve the 30‑hour forecast of boundary layer height.  To edit the values, simply click on an existing value for a time of interest and type in the new value.  A value can be copied by selecting a value and pressing [CtrlC], then pasted to a new location by pressing [Ctrl‑V].  Refer to Figure 1-19.

Boundary layer height is used by the IR, TV/NVG, and Laser models; this is the height at which the boundary, or surface, layers ends and the upper layer begins.  TAWS use a two‑layer model of the atmosphere.  Meteorological parameters are defined for each of the two layers, and the layers are separated at the boundary layer height.  The boundary layer represents a homogeneous region in terms of stability, aerosol content, and moisture.  It may be capped by an inversion.  According to Holton (1979), the boundary layer height varies from about 1 hft for conditions of large static stability to about 100 hft for highly convective conditions.  For conditions of extreme instability, it may be difficult to define a boundary layer at all.  However, the models require this parameter.
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Figure 1-19.  Boundary Layer Height

Upper Layer  Temperatures.  The Upper Layer Temperature window allows you to edit or approve the 30‑hour forecast of average upper layer temperature and dew-point temperature.  The temperature values can be edited by clicking on the Temperature button, then clicking on the value for the time of interest and typing in the desired value.  The dew-point values can be edited by clicking on the DewPoint button, then clicking on the value for the time of interest and typing in the desired value.  Temperature and dew-point values can be copied by selecting a value and pressing [CtrlC], then pasted to a new location by pressing [Ctrl‑V].
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Figure 1-20.  Upper Layer Temperature
The upper layer temperature and dew-point temperature is used by the IR, TV/NVG, and Laser models primarily to compute the relative humidity.  Relative humidity, along with aerosol and visibility, is used to compute an extinction coefficient.

Upper Layer Visibility.  The Upper Layer Visibility window allows you to edit or approve the 30‑hour forecast of average visibility in the upper layer.  To edit the values, simply click on an existing value for a time of interest and type in the new value.  A value can be copied by selecting a value and pressing [CtrlC], then pasted to a new location by pressing [Ctrl‑V].  Upper layer visibility is used by the IR, TV/NVG, and Laser models.
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Figure 1-21.  Upper Layer Visibility
Upper Layer Aerosol.  The Upper Layer Aerosol window allows you to edit or approve the 30‑hour forecast of upper layer aerosol.  To edit the values, simply click on one of the radio buttons for a time of interest: Rural, Urban, Maritime, or Tropospheric.
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Figure 1-22.  Upper Layer Aerosol
Aerosol is used by the IR, TV/NVG, and Laser models.  This parameter describes the primary particulates of the air mass in the upper layer at the location of interest.

TAWS supports up to three cloud layers: one each of high, middle, and low.  To edit the cloud information, click on either the High Level Clouds..., Mid Level Clouds..., or Low Level Clouds...  button in the TAWS Meteorological Data window.  The appropriate Cloud Information window appears.  The window contains the following parameters.  Refer to Figure 1-23.
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Figure 1-23.  Cloud Information - Low Cloud Example
Cloud Type.  The type of cloud in a given layer.  TAWS supports 2 possible low-level cloud types: St/Sc and Cu/Cb.  TAWS support 2 possible mid level cloud types: As/Ac and Ns.  TAWS support 2 possible high-level cloud types: Thin Ci/Cs and Thick Ci/Cs.  To change the cloud type, click on the appropriate radio button.

The IR and TV/NVG models use all three cloud layers.  The Laser model uses only the low-level clouds.  

Cloud Amount.  The amount of cloud cover for a given cloud layer.  To change the cloud amount, click on the existing value for a time of interest and type in a new value.  A value can be copied by selecting a value and pressing [CtrlC], then pasted to a new location by pressing [Ctrl‑V].

The base height of a given cloud layer.  The cloud level puts a constraint on the allowable base heights.  Low clouds are constrained to have a base height between 1 and 65 hft.  Middle clouds are constrained to have a base height between 65 hft and 200 hft.  High a Cloud Base Height clouds are constrained to have a base height between 200 hft and 450 hft.  To change the cloud base height, click on the existing value for a time of interest and type in a new value.  A value can be copied by selecting a value and pressing [CtrlC], then pasted to a new location by pressing [Ctrl‑V].

When you are finished reviewing and modifying any of the weather parameters, you can click on the OK button in the parameter window to save your changes and return to the TAWS Meteorological Data window.  Click on the Cancel button to close the parameter window without saving your changes.  Note that when you click on the OK button in the parameter window to finish editing the parameters weather, TAWS considers you to have approved the values for all the parameters in that window.  If you examine those parameter values again, the non‑editable text box will indicate that the weather source is User.  When you return to the TAWS Meteorological Data window, the summary information for the required parameter that you edited is updated.

When you are finished reviewing and modifying the weather altogether, you can click on the OK button in the TAWS Meteorological Data window to save your changes and return to the Point‑Based Target Acquisition window.  Click on the Cancel button to close the TAWS Meteorological Data window without saving your changes.

Note: When you click on the OK button in the TAWS Meteorological Data window, the times of the 30‑hour weather window are set for that location.  If you then make small adjustments to the TOT for that location (+ or ‑ 12 hours), the actual times of the weather window will not be changed.  This allows you to keep your forecast for the location.  The amount of time for which TAWS model output is available may change, depending on how your desired output time window fits within the weather window.  If you make large adjustments to the TOT for your location (greater than 12 hours), then you must enter a new forecast with a new weather window (new TOT18 to new TOT+1 2 hours).

Analyzing the Target

Once you have specified consistent target, sortie, and weather information, you can click on the Analyze...  button in the Point‑Based Target Acquisition window to run a target acquisition analysis.  Note that if you change your target location or your sortie date/time, you must review the weather information before you can run an analysis.  In this case, the Analyze...  button is inaccessible.

When you click on the Analyze...  button, a drop‑down list appears showing the different types of analysis: Analyze over Time...  and Analyze over View Direction...  If you select Analyze over Time..., the Analyze over Time window appears on the screen.  If you select Analyze over View Direction....  the Analyze over View Direction window appears on the screen.  The subsections below describe the two different types of analyses.  Refer to Figure 1-24.
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Figure 1-24.  Point-based Target Acquisition - Analyze...
Analysis over Time.  This section describes the type of target acquisition analysis that calculates the detection and/or lock‑on range for various times bracketing the time over target.  If you select Analyze over Time...  from the drop‑down list in the Point‑Based Target Acquisition window, the Analyze over Time window appears on the screen.  This window displays the current target in the 

Target box.  Refer to Figure 1-25.
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Figure 1-25.  Analyze Over Time
The Analyze over Time window shows the view direction to be used for the analysis.  This is the view direction, or azimuth angle, of the sensor in degrees clockwise relative to north.  For analysis over time, only a single value of view direction is allowed.  The initial value corresponds to the default view direction that was specified in the Sortie Properties window.  To change this value, click on the arrows in the spinner box or type in a value.

The Analyze over Time window also includes a button that allows you to adjust the analysis parameters.  To adjust the parameters, click on the Analysis Properties...  button.  The Target Acquisition Analysis Properties window appears on the screen.  A target acquisition analysis may be run for a range of times bracketing the actual time over target (TOT) and a range of sensor altitudes bracketing the actual sortie vehicle altitude.  This window allows you to set these ranges and the increments.  See target acquisition analysis defaults for more information about the parameters in this window.  When you are finished specifying the analysis parameters, you can click on the OK button to save your changes for the current session and return to the Analyze over Time window.  Click on the Cancel button to close the Target Acquisition Analysis Properties window without saving your changes.  Refer to Figure 1-26.
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Figure 1-26.  Target Acquisition Analysis Properties
You are now ready to run the analysis.  Click on the Run Model button in the Analyze over Time window.  The models will be run for the specified sensors, the specified target, the range of backgrounds, the range of times, the applicable target scene lighting conditions (for TV/NVG sensors), and the range of sensor altitudes.  When the analysis is complete, you are returned to the Point‑Based Target Acquisition window.

Analysis over View Direction.  This section describes the type of target acquisition analysis that calculates the detection and/or lock‑on range for various view directions.  For this type of analysis the view directions correspond to the eight compass points.  If you select Analyze over View Direction...  from the drop‑down list in the Point‑Based Target Acquisition window, the Analyze over Azimuth window appears on the screen.  This window displays the current target in the Target box.  Refer to Figure 1-27
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Figure 1-27.  Analysis Over View Directions
The Analyze over Azimuth window shows the Time over Target to be used for the analysis.  For analysis over view direction, only a single value of TOT is allowed.  The initial value corresponds to the default TOT that was specified in the Sortie Properties window.  To change this value, click on the arrows in the hours and minutes spinner boxes or type in values.

The Analyze over Azimuth window also includes a button that allows you to adjust the analysis parameters.  To adjust the parameters, click on the Analysis Properties...  button.  The Target Acquisition Analysis Properties window appears on the screen.  A target acquisition analysis may be run for a range of times bracketing the actual time over target (TOT) and a range of sensor altitudes bracketing the actual sortie vehicle altitude.  This window allows you to set these ranges and the increments.  See target acquisition analysis defaults for more information about the parameters in this window.  When you are finished specifying the analysis parameters, you can click on the OK button to save your changes for the current session and return to the Analyze over Azimuth window.  Click on the Cancel button to close the Target Acquisition Analysis Properties window without saving your changes.

You are now ready to run the analysis.  Click on the Run Model button in the Analyze over Azimuth window.  The models will be run for the specified sensors, the specified target, the range of backgrounds, the range of view directions, the applicable target scene lighting conditions (for TV/NVG sensors), and the range of sensor altitudes.  When the analysis is complete, you are returned to the Point‑Based Target Acquisition window.

Viewing Results ‑ Tabular Output

Once you have run an analysis for your target, click on the View Table...  button in the Results box in the Point‑Based Target Acquisition window, or select Table from the View menu.  The Choose Table Contents window appears on the screen.  This window shows the target type in a non‑editable text box.  The selection of analyzed sensors is shown in a drop‑down list box.  Select one of the sensors in the list by clicking on it.  The available output table types for that sensor are then shown in a drop‑down list box.  TAWS supports different table types for the different types of sensors:

Table 1-3.  Tabular Outputs
Sensor Type
Table and Plot Types

IR
Range

Temperature

Delta T

Illumination

TV/NVG
Range

Illumination

Active TV
Range

Laser Mode 1
Receiver Range

Designator/Receiver Range Pairs

Laser Modes 2, 3
Designator Range

Designator/Receiver Range Pairs

Laser Modes 4, 6
Designator Range

Ranging Range

Designator/Receiver Range Pairs

Laser Mode 5
Receiver Range

Ranging Range

Designator/Receiver Range Pairs

Laser Mode 7
Ranging Range

Each type of table contains several TAWS output products.  Select one of the output table types in the list by clicking on it to highlight it.  Then click on the Generate Table button.

For an IR sensor, the Range table contains several output products: detection range for narrow FOV, detection range for wide FOV, and lock‑on range.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a row of data for each view direction.  The table header allows a choice of background and sensor altitude.  Note that some of the range products are not available for every sensor; ranges that are not available are listed as 0.0 in the table.  If a sensor has a single FOV, results are reported in the WFOV column.

The IR Temperature table contains background temperature, target temperature for NFOV detection, target temperature for WFOV detection, and target temperature for lock‑on.  Again, if a sensor has a single FOV, results are reported in the WFOV column.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a row of data for each view direction.  The table header allows a choice of background and sensor altitude.

The IR Delta T table contains the difference between target and background temperature for NFOV detection, delta T for WFOV detection, and delta T for lock-on.  Again, if a sensor has a single FOV, results are reported in the WFOV column.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a row of data for each view direction.  The table header allows a choice of background and sensor altitude.

The IR Illumination table contains solar elevation angle, solar azimuth angle, lunar elevation angle, lunar azimuth angle, percent lunar illumination, and IR visibility.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a single row of data for the specified output time.

For a TV/NVG sensor, the Range table contains several output products for the target either in direct sun/moonlight or no direct sun/moonlight: detection range for narrow FOV, detection range for wide FOV, and lock‑on range.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a row of data for each view direction.  The table header allows a choice of background and sensor altitude.  Note that some of the range products are not available for every sensor; ranges that are not available are listed as 0.0 in the table.  If a sensor has a single FOV, results are reported in the NFOV column.

The TV Illumination table contains solar elevation angle, solar azimuth angle, lunar elevation angle, lunar azimuth angle, percent lunar illumination, probability of target in direct sun/moonlight, and weather‑impacted ground illumination.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a single row of data for the specified output time.

For an active TV sensor, the Range table contains detection range.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a row of data for each view direction.  The table header allows a choice of background and sensor altitude.

For a Laser system with Modes 1 or 5, the Receiver Range table contains receiver range for the target.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a single row of data for the specified output time.

For a Laser system with Modes 2, 3, 4, or 6, the Designator Range table contains designator range for the target.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a single row of data for the specified output time.

For a Laser system with Modes 4, 5, 6, or 7, the Ranging Range table contains ranging range for the target and each background.  For a target acquisition analysis over time, the table contains a row of data for each output time.  For a target acquisition analysis over view direction, the table contains a single row of data for the specified output time.

For a Laser system with Modes 1, 2, 3, 4, 5, or 6, the Designator/Receiver Range Pairs table contains receiver ranges for a series of designator ranges.  For a target acquisition analysis over time, the table contains data for the last output time.  For a target acquisition analysis over view direction, the table contains data for the specified output time.

Note that some of the output products are not applicable or not available for a particular time.  In addition, the sensor‑to‑target line‑of‑sight may be blocked by an overcast cloud layer for a particular output time.  To see an explanation for situations where no range or corresponding temperature is available, select Codes from the Results menu.

To print the tabular output, select Print from the File menu, with the relevant table as the active window.  The tabular output is automatically sent to your default Windows printer.

To save the tabular output to a text file, select Save Results As.  from the File menu, with the relevant table as the active window.  The Save As window appears on the screen.  You have the opportunity to enter a file name, file type, and folder.  Click on the Save button to save the file and close the Save As window.  Click on the Cancel button to close the Save As window without saving the file.

You can manipulate the table window using standard Windows functions.  You can click on the Minimize or Maximize buttons or drag the window title bar.  You can use the Tile or Cascade options in the Window menu.  You can then generate other tabular or graphic output products or run another analysis.  When you are finished looking at the table, click on the Close button to close its window.

Viewing Results ‑ Graphic Output

Once you have run an analysis for your target, click on the View Graph...  button in the Results box in the Point‑Based Target Acquisition window, or select Graph from the View menu.  The Choose Plot Contents window appears on the screen.  This window shows the selected target type in a non‑editable text box.  The selection of analyzed sensors is shown in a drop‑down list box.  Select one of the sensors in the list by clicking on it.  The available output plot types for that sensor are then shown in a drop‑down list box.  TAWS support different plot types for the different types of sensors.  Select one of the output plot types in the list by clicking on it to highlight it.  Depending on the selected sensor and plot type, other list boxes may be provided for sensor altitude, target background, range type, and lighting conditions.  You can select multiple choices in a single category and one choice in each of the remaining categories.  To select one value, simply click on that choice.  To select more than one, click on the first one and hold down the [Ctrl] key while clicking on the others.  To select a range, click on the first one and drag the cursor down the list.  When you have completed your selections, click on the Generate Plot button.  Refer to Figure 1-28.
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Figure 1-28.  Choose Plot Contents
For a target acquisition analysis over time, range, temperature, or delta T plots are Cartesian plots of the parameter as a function of time.  One or more series of data will be shown, depending on your selections in the Choose Plot Contents window.  The weather‑impacted ground illumination plot is a semi‑log plot of the parameter as a function of time.  The Designator/Receiver Range Pairs plot is a Cartesian plot of Receiver Range versus Designator Range for the last output time.  For a target acquisition analysis over view direction, the IR or TV range plot is a polar plot of the parameter as a function of view direction.  Again, one or more series of data will be shown, depending on your selections in the Choose Plot Contents window.  The Designator/Receiver Range Pairs plot is a Cartesian plot of Receiver Range versus Designator Range for the analysis time.  Since weather‑impacted ground illumination and the other Laser ranges do not vary with view direction, these plots are not available.  Refer to Figure 1-29.
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Figure 1-29.  Detection Range vs Time - Graphical Output Example
Note that plots may have missing values for some or all times or view directions.  To see why a value is missing, look at the corresponding output table.  Results codes are displayed for these times or view directions.  To see an explanation for the results codes, select Codes from the Results menu.

To change the appearance of the plot, use the mouse to right‑click on the plot.  A window appears and allows you to change the plot titles (header and footer), axes (x and y), and legend (data series labels).  You can change the actual text that is displayed, the font of the text, the minimum/maximum values on the axes, and more.  Use this feature to tailor the graphic output products for your own needs.  For example, to remove potentially classified information from the plot (location, date, and sensor ID), right‑click on the plot, then select Titles Footer General and uncheck the IsShowing box.

To print the graphic output, select Print from the File menu, with the relevant plot as the active window.  The graphic output is automatically sent to your default Windows printer.

To save the graphic output to a bitmap file, select Save Results As.  from the File menu, with the relevant plot as the active window.  The Save As window appears on the screen.  You have the opportunity to enter a file name, file type, and folder.  Click on the Save button to save the file and close the Save As window.  Click on the Cancel button to close the Save As window without saving the file.

You can manipulate the plot window using standard Windows functions.  You can click on the Minimize or Maximize buttons or drag the window title bar.  You can use the Tile or Cascade options in the Window menu.  You can then generate other tabular or graphic output products or run another analysis.  When you are finished looking at the plot, click on the Close button to close its window.

SUMMARY


During this period of instruction you have been taught that “TAWS” is the software Marine Weather utilizes to produce EOTDA products.   These products are the very tools that the war fighter will use to put metal on target.   In order to serve your customer well you must have a thorough understanding of the TAWS program and your customers needs and capabilities.

REVIEW EXERCISE 1

Encode the following EOTDA input data, then answer out-put questions on the answer sheet provided.   

A strike is planned against a location using IR 21 Knight weapon systems.   The following information is given to you by the Mission Commander and Weather Officer to prepare a brief:

Date of attack:  03/15/00

Location:  25.00SYMBOL 176 \f "Symbol"N  95.00SYMBOL 176 \f "Symbol"W

Dew Point:  55 SYMBOL 176 \f "Symbol"F


Aerosols:  Martime (non-navy)

Boundary layer:  500 ft

Upper Lvl Defaults:  standard

Forecasted max//min temps:  75/ 62  SYMBOL 176 \f "Symbol"F

SCT Conditions = 4/8    BKN Conditions = 5/8

SCT Conditions = thin    BKN Conditions = thick

After a complete analysis of all available products, you prepare the following forecast for attack location "KYYY"

KYYY TAF 151212 33006KT 9000 HZ SCT250 QNH2995INS

            BECMG 1618 02010KT 9999 SCT030 SCT250 QNH2992INS 

            BECMG 0103 04012KT 9999 BKN025 BKN250 QNH2990INS 

            BECMG 0709 35005KT 9999 SCT025 BKN250 QNH2995INS

After discussing the forecast with the Mission Commander, you are given the following weapon and target data:

Weapon type:            IR 21 Knight

ID number:  1005

Viewing direction:    090SYMBOL 176 \f "Symbol"


Sensor Ht:   40Hft

Complexity                High


Elevation:    18.0 ft MSL

Target:     Gunboat

Heading:  200SYMBOL 176 \f "Symbol"
Albedo:    Ocean

Slope:      0° (level)

Background:  Water, depth 75 feet, clear.

Run data: 60 min intervals.

Use the output to answer the following questions:

1. Utilizing the WFOV, when will the best detection ranges occur?

2.    Utilizing the NFOV, during what time frame will the shortest detection ranges occur? 
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